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Login

To login to Smartetools, set your web browser to the address designated by your
district network administrator.

The address for your district is:

The Smartetools login page will appear.

W | & User Login

j Smartetools

Smartetools User Login:

Login Name:

Password:

Enter your username and password. The password is case sensitive which
requires that you enter the password using the correct lower and upper case
characters. Once you successfully login you will be presented with the Main
Menu.

My Login Name is:
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The Main Menu displays the functional areas for which you are authorized. The
menu bar below shows Purchasing, Stock, GL, and Reports. To access the items
within each of these areas, click on the desired area.

Smartetools Unified School District

Last Login: 11/27/2009 10:44 AM
Fiscal Year: 2010
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Function: Main Menu
User: Administrator, System

The File menu allows you to change your password, access the Smartetools on-
line help and logout of Smartetools.
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Function: Main Menu

User: Administrator, System

-

Smartetools Unified School District
Last Login: 11/27/2009 10:44 AM
Fiscal Year: 2010

The Purchasing menu will display the following information.

= =
o Irg Purchase Requisition Listing ] I oo v (= v [ Page v {J Tools »
Smartetools Unified School District
Function: Purchase Req Listing Last Login: 11/27/2009 10:44 AM
User: Administrator, System Fiscal Year: 2010
Purchase Req Pu e Req
Filter: Awaiting Processing ~ ( 117 Requisitions )
Viewing Page 1 of 3
123
Req Number PO Number PO Print Date First Account Number Vendor Current Step A:::::;t
HaM
MECHANICAL -
Select |R1000454 010-81500-0-11100-81100-5810-805-0000 g W =4t - School Principal / Dept Head  $14,347.99

(19337)
HaM
MECHANICAL o

R1000453 010-81500-0-11100-81100-5810-805-0000 Gre AN =t . School Principal / Dept Head  $14,670.08
(19337)

R1000451 010-58103-0-11100-10000-5810-705-0000 LACOE (LACOE) School Principal / Dept Head  $750.00
HaM
MECHANICAL .

R1000450 010-81500-0-11100-81100-5810-805-0000 g rinen~ School Principal / Dept Head $14,883.77
(19337)
HaM
MECHANICAL

Select |R1000449 010-81500-0-11100-81100-5810-805-0000 LECRANEAT  school Principal / Dept Head $14,555.00

(19337)
HaM
MECHANICAL -

R1000448 010-81500-0-11100-81100-5810-805-0000 gre 18~ - School Principal / Dept Head $14,673.00
(19337) =

Done B 0 Internet | Protected Mode: Off H100% -
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A list of requisitions that are Awaiting Processing will be displayed. This list
may be empty. The Awaiting Processing list is a list of requisitions that you
have entered into the system and have routed. They are in the process of being
approved but have not yet been assigned to a purchase order.

Use the drop down list to select a status to display a list of requisitions for that
status. The other options are New Requisitions and Completed.

e i IE Purchase Requisition Listing l_l ﬁ -2 - @ 2 I_;} Page = @Tools -7

Smartetools Unified School District
Function: Purchase Req Listing Last Login: 11/27/2009 10:44 AM
User: Administrator, System Fiscal Year: 2010

mn

Purchase Req Listing || Purchase Reg

Filter:  Awaiting Processing ~|( 117 Requisitions )

Viewing Page 1 of 3

Awaiting Processing
123 [Completed i
Regq Mumber PO Number PO Print Date First Account Number Vendor Current Step lote

Amount

Lign

The New Requisitions status will list the purchase requisitions that you have
entered but have not yet routed. The Completed status will list all of your
purchase requisitions that have been processed within the fiscal year.

To work with a requisition, click the Select button next to the requisition number.
This will display the requisition and allow you to edit, route, print, and perform
other functions related to the requisition. You can also create a new purchase
requisition.

e dhr I@F’urchﬂse Requisition [_l @ -2 2 E;:‘s - gPage > @Touts P

-

Smartetools Unified School District W
Function: Last Login: 11/27/2009 10:44 AM
User: Administrator, System Fiscal Year: 2010

Purchase Req Listing || Purchase Req

| Savwe | f Caﬂ:»:-‘r | Copy Reg Templates [ History H Xactions H Notes H Print ]

Action: Send to -Igljrc:hasi.ﬁguli.]eparlﬁ’nel'.l.t"f-r.:»r pmcsss-img B A
Requisition #: R1000419 . Purchase Order #:Not Assigned Current Step:BudgetFiscal Services

Vendor #:11035

PRE55 TELEGRAM - Requested By:D. Takahama

CLASS5IFIED AD DEPARTMENT

604 PINE AVE Requested For:Printing shop outsourcing L 4
LONG BEACH CR 90802

Phone: (562) 499-1206 Deliver Site:Purchasing/Warehouse

Fax: (562) 495-4227 - Ry

Date Meeded: 08/24/2009

Auto Distribute by Percent: Yes Status: Open | ReCalculate |

[3]
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Accounts
Line Pseudo Account Number Percent Amount PreEncumbrance i
1 580939 010-00000-0-00000-75300-5830-803-0000 100.00 453.16 453 ‘IE!
Items
Line # Description unit Issue Qty Unit Cost  Taxable Ship Amt SubTotal Delete!
Legal Ad for RFP#: 1-0910 District wide -
Reprographics Printing Senvices 3 L Be | i 200 st E
Somments: = Subtotal: 45316
Shipping Total: l 0.00
Tax: @ 975%| 0.00
i Total: 453.16
E; e Internet | Protected Mode: Off H100%

From this screen, you can also search for another requisition, display the routing
history of the requisition and attach notes to the requisition.

Note that the account number may be displayed in Red. This is a visual indicator
that the account does not have sufficient funds for the requisition.

Create a Requisition

To create a new purchase requisition, click the New button.

oo [ {& Purchase Requisition l l
Smartetools Unified School District
Function: Last Login: 11/30/2009 02:11 PM
User: Administrator,System Fiscal Year: 2010
Purchase Req Listing || Purchase Req
\ Edit Save Cance Copy Reg Templates [ History ” Xactions ” Motes ” Print ]
Action: Send to Budget / Fiscal Senvices for processing -

This will present a blank requisition page. Begin by entering the “Requested By”
and “Requested For” information. Select the Deliver Site by using the drop down
selection box. If your user profile only allows access to your site, then only one
site will be available for selection. Enter a contract number if this requisition is to
reference a contract. The date needed will default to 14 days from the date the
requisition is created. Enter a new date needed if it is different than the default.

In order to save a requisition, the following fields must be completed: “Requested
By”, at least one Account Number, and at least one Line Item.

If you would like to select a vendor for the requisition, you can activate the

Vendor Search function to search for a vendor by clicking on the Vendor Search
button.

[4]
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W o I@Purchaseﬂequisi‘tmn lil @ x S @a v |isk Page @Touks e

Smartetools Unified School District
Function: Last Login: 11/27/2009 02:32 PM
User: Administrator,System Fiscal Year: 2010

Purchase Req Listing || Purchase Req

m

[ New |[ Edit [ Save ” Cancel ]'S.—:a.:'h [ Copy Req H Templates l Histaory Xactions |[ Notes |[ Print

Action: | Send to Purchasing Department for processing

Requisition #: Go ] Purchase Order #: Current Step:

Vendor #I

Requested By:lSysIem Administrator *

Requested FUr:l
Deliver Site: Adult School A

~ Contract #:

Date Neededfiziizzo08 - &3]
Auto Distribute by Percent: Status: Open ReCalculate

When entering accounts, the cost of the requisition can be allocated by percent
by leaving the Auto Distribute by Percent check box checked. To use a different
method of cost allocation, uncheck this box. Allocation of the cost of the
requisition will be discussed later in this document.

At any time during the entering of a new requisition or editing an existing
requisition, you may click the ReCalculate button. This will validate information
on the requisition such as account numbers, calculate the line items totals and
total cost of the requisition and redistribute the cost allocated to each account
number if the Auto Distribute by Percent method is used.

[5]
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Vendor Search

The Vendor Search page allows searching for vendors using a combination of
search criteria. A list of vendors that match the search criteria is displayed. In this
example, Vendor Name is “Office” and the State is “CA”. This produced a list of
seven vendors that have “Office” in the Name and are located in California.

Search By:

Vendor Number:
Vendor Name: Office
Category: - Mone - -
City: State: CA -

Tax [.D. Number:

I Search ] [ Close J I Reset I [Suggest\fendor

5 accounts found.

Vendor # Vendor Name Address City DoNotUse
@ 10431 OFFICE DEPOT 3366 E WILLOW 5T SIGMAL HILL O
OFFDEPOT OFFICE DEPOT P.O. BOX 70049 LOS ANGELES 0
Select | 16039 OFFICEMAX 4949 LAKEWOOD BLVD LAKEWOOD 0
Select | OFFICEMAX OFFICEMAX CONTRACT INC. P. 0. BOX 79515 CITY OF INDUSTRY O
@ 19799 OFFICETRONICS 6780 MIRAMAR ROAD SAN DIEGO 0

To select a vendor in this list, click on the Select button next to the desired
vendor. This will close the Vendor Search page and copy the vendor information
into the requisition. You can also search for a vendor by category if your district
has defined vendor categories and assigned vendors to these categories.

A vendor is not required in order to submit a purchase requisition. If a desired
vendor is not found, click on the Suggest Vendor button and enter the
information of the vendor you wish to suggest. This allows vendor information to
be submitted with a requisition that may not be in the vendor file.

[6]
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Search By:

Vendor Number:
Vendor Name:
Category: - MNone - -
City: State: - Mone - -

Tax 1.0, Number:

[ Close Jl Reset HSuggestVendur

m

Suggest
Vendor

Vendor Name 1: Joe's Computer Shop
Vendor Name 2:
Phone:
Address 1: 123 Main Street
Address 2:

City: Anywhere

State: CA - ZipCode: 91234
Contact:
Save Suggest | | Cancel |
_!:- @ Internet | Protected Mode: On H100% -

Once you have filled in the suggested vendor information, click the Save
Suggest button and the information will be copied into the purchase requisition.

At this point, information at the top of the requisition is complete. The next step is
to assign the account(s) that will be used to pay for the requisitioned items.
Depending on the configuration selected by the district, you may enter more than
one account or be restricted to a single account on a requisition.

[7]
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Account Search

The center portion of the Purchase Requisition page contains the account
information. To assign an account number to the requisition, click the Account
Search button to activate the Account Search page.

- »
W (& Purchase Requisition | | f-} 7 ~ = w |k Page » (i} Tools v
Requisition #: R1000419 Purchase Order #:Not Assigned Current Step:BudgetfFiscal Services
Vendor #:/11035 a)
PEESS TELEGRAM i Requested By:[D. Takahama *
CLASSIFIED AD DEPARTMENT
604 PINE AVE Requested For:|Printing shop outsourcing
LONG BEACH CA 90802 . n
Phone: (562) 499-1206 Deliver Site: Purchasing/\Warehouse -
Fax: (562) 4895-4227 o Contract £: H|

Date Needed:[ggpa2000 = @

Auto Distribute by Percent: [#] Status: Open
Accounts
Line Pseudo Account Number Percent Amount PreEncumbrance
1 [010-00000-0-00000-75300-5830-803-0000 [“100.00 45316 453.16
2 [ & [ [ oo0 0 0.00
z [ o4& [ [ ooo 0 0.00
a [ & | [ oo0 0 0.00
s [ & | [ oo 0 0.00
e [ & [ [ oo 0 0.00 o
(@ € Intemet | Protected Mode: Off H100% -

The Account Search page allows you to search for and select an account
number. Depending on your user profile, you may be limited to the account
numbers you are allowed to access.

Search By:

Fund(3) Res(5) Yr(1)  Goal(5) Fnct(5) Obj(4) Loc(3) Dept(4)
Account Number: 010 ] | | -77000 -43 - &

Pseudo:

Account Name:

lSearch‘ l Close ] l Resetl

4 accounts found.

Pseudo Account Number Budget Balance PreBalance
432015 010-00000-0-00000-77000-4340-811-0000 $28,000.00 $25,137.05 $25,059.77 | Xactions |
432124 010-00000-0-00000-77000-4350-811-0000 $7,600.00 $7,543.98 $7,543.98  Xactions |
432246 010-00000-0-00000-77000-4361-811-0000 $1,200.00 $1,200.00 $1,200.00 | Xactions |
432317 010-00000-0-00000-77000-4390-811-0000 $70,400.00 $59,143.30 $50,319.49 | Xactions |
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Enter the account search criteria and click the Search button. A list of accounts
to which you have access via your user profile will be displayed. The Budget,
Balance, and PreBalance are also displayed for reference. Click on the Select
button next to the desired account and it will be copied to the requisition.

If you do not know all of the digits of an account number for a group of accounts,
leave those digits blank, or use an underscore “_” as a place holder. The account
search will treat the spaces or underscores as a wild card character and return all
the accounts that match the digits entered. The example above shows that the
Resource, Year and Goal were left blank as well as the last two account

components. The Object portion of the account has the first two digits entered.

The purchase requisition allows for five accounts initially. To assign more than
five accounts to a requisition, save the requisition and then click the Edit button.
The requisition will show the five original accounts and five more blank account
lines that may be used for additional accounts.

If the Auto Distribute by Percent  Auto Distribute by Percent: [V pox is checked,
(located just under the vendor information) then you will be able to enter a
percentage that is used to compute the amount to be allocated to the account.
This is the percentage of the total cost of the requisition as determined when all
line items have been entered.

To allocate the cost of the requisition without using the percent method, uncheck
the Auto Distribute by Percent box. You can then enter the amount for each
account in the account Amount box. Using this method, the amounts allocated to
the accounts must be equal to the total amount of all of the line items including
sales tax and shipping. The allocation must be exact.

A third method for allocating the cost of line items to the accounts allows the
assignment of each line item to an account line. Choose the account line number
from the account list.
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ﬁ ahe [@ Purchase Requisition l_l & x it @ hd Qpage 52 @Tools Gt

Accounts
Line Pseudo Account Number Percent Amount PreEncumbrance

1 [pRosas | &) [010-00000-0-00000-75200-5230-803-0000 0 [ im0 45316
2 [seooa0 &) [010-00000-0-11700-71500-5830-501-0000 o [ sz 0.00
3 [ 8 | 0 [ 0 0.00
[ EN [ o 0 0.00
s [ ® | L
| [ o

£

0.00 g
6 | &) 0 0.00
Items
L';E Acct Description unit Issue Qty Unit Cost Taxable Ship Amt SubTotal Tax Delete| |5
Legal Ad for RFP#: 1-0910 District wide - ,—
& Reprographics Printing Services i | I il L 000 45316 000 [
| \ - | | | 0.00 0.00 000  0.00 |4
-
U 7 | | of 0.00 0.00 000 0.00
5 | | | 0.00 0.00 000 0.00
5 - i | | o 0.00 0.00 000  0.00 i\
Done E@. 0 Internet | Protected Mode: Off 100% v

When using the line item account number assignment method, all line items must
be assigned to account lines. A combination of methods is not allowed.

The last section of the requisition page is used to enter the items requested.

W o [@ Purchase Requisition lil @ 5 5 @ v |i2s Page ¥ .Q;] Tools »
Items >
P Acct Description Unit Issue Qty Unit Cost Taxable Ship Amt SubTotal Tax Delete
Legal Ad for RFP#: 1-0910 District wide -
1 - i Reprographics Printing Services - l l I 45350 O 000 45310 0.00 [
2 - I u I | of 0.00 0.00 0.00  0.00
3 - I : [ | | 0.00 | 0.00 0.00  0.00
4 - | 3 [ | | 0.00 | 0.00 0.00  0.00
5 - I 5 [ | o 0.00 | 0.00 0.00  0.00
° v-I . | I o] 0.00 0.00 0.00  0.00
7 - I & [ [ o 0.00 [ 0.00 0.00  0.00
8 - I e [ | o 0.00 | 0.00 0.00  0.00
9 - I : [ | | 0.00 0.00 0.00  0.00 |
e - subtotal: 45316
Shipping Total: 0.00
Tax: @ 975 %] 0.00
= Total: 453.16
=
Done [ & Internet | Protected Mode: Off H100% ~
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Enter a Description of the item, Unit of Issue, Quantity and Unit Cost. If the item
is known to be taxable, then leave the tax box checked. Uncheck the tax box if
the item is not taxable. Enter shipping charges in the Ship Amt box. In order to
enter an expanded description for a line item, click the Description Entry Button.
This will display a page allowing free formatting of the description. If the
description to be entered is short, it can be entered without having to use the
expanded description entry page.

Line Item Description:

Legal Ad for RFP#: 1-0910 District wide Reprographics E
Printing Services

Publication Date:

Friday, July 31, 2009

Friday, August 7, 2008

Save || Close

Click the Save button to close the expanded description entry page and copy the
item description to the requisition. The complete description will appear on the
printed requisition.

Once the line items have been entered, you can enter comments at the bottom of
the requisition. These are general comments that will display with the requisition.

EEEIELE - Subtotal: 453,16

Shipping Total: 0.00 1
Tax: @ 9.75%)] 0.00
Total: 45316

Done ; @ Internet | Protected Mode: Off #100% ~
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Once the requisition is complete, it can be saved by clicking the Save button at
the top of the requisition. If any errors are found, you will be notified and asked to
correct the problem. You can cancel the creation (or edit) of a requisition by
clicking the Cancel button.

Possible errors with the requisition include:

¢ No account number was entered.

¢ More than one account was used when multiple accounts have been
disabled.

e The accounts do not conform to the multiple accounts constraint defined
by the district.

e Aline item exists that has a quantity but no unit cost.

¢ Aline item exists that has a unit cost but no quantity.

e The Auto Distribute by Percent has been unchecked and there is a
problem with the account amount distribution.

If any of these errors occur, the error will have to be corrected before the
requisition can be saved.

Once a requisition is saved, it will be displayed with all of the information. The
menu at the top of the requisition will now have many more options.

[12]
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Edit a Requisition

Requisition Search

To edit a requisition, click the Select button next to the Requisition in the
purchase requisition listing. You can also use the Requisition Search function to
find the requisition you wish to edit. To activate the search function, click the
Search button on the menu. The Purchase Requisition Search page will be
displayed. Enter the criteria you wish to use to search for a requisition. To see a

list of all requisitions to which you have access, click the Search button without
entering any search criteria.

Search By:

Requisition Status: All x @ Requisitions Waiting for Review and/or Routing

Requisition Number: Requisitions Previously Reviewed and/or Routed
Item Description:
Vendor Name:

Requisition Diate From: To:

m

[ Search I ICIuse | IReset |
5 purchase requisitions found.
Req Date Date ; Vendor Total
Number  Entered Needed Fant St Prnler Number SIS Amount

Select |RO0201 05/25/2007 06/08/2007 010-72600-0-11100-10000-4400-404-0000 276069 New Purchase Reg $1,100.00
Select |R00003 05/25/2007 06/08/2007 010-00000-0-00000-31100-4410-407-0000 274992 New Purchase Reg $10,825.00
Select |ROO00D2 05/25/2007 06/08/2007 010-00000-0-00000-21300-4350-000-7032 272424 New Purchase Req $1,082.50
Select |ROO0DL 05/25/2007 06/08/2007 010-00000-0-00000-27000-4400-403-0000 272217 New Purchase Reqg $1,082.50
Select |ROO0DO1 05/25/2007 06/08/2007 010-00000-0-00000-27000-4400-401-0000 275884 New Purchase Req $1,082.50

Done [# € Internet | Protected Mode: On H100% ~

To select a requisition, click on the Select button next to the desired requisition.
This will close the search page and display the requisition. Assuming you have
access to edit the requisition, click the Edit button at the top of the page. The
requisition edit page will be displayed allowing you to change the information on
the requisition. Once you have completed your changes, click the Save button.
You can cancel your changes by clicking the Cancel button. The Edit page
allows the same types of entries as the creation page. Therefore, when editing a

requisition you should follow the same procedures as when you created the
requisition.

Once a requisition is displayed, refer to the menu at the top of the page for
actions that are available for the requisition. If the requisition has been routed,
the Edit button may be missing. A requisition can only be edited if it is at a
location/step to which you have access. Once it has been routed and is in the

[13]
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approval process, the originator may no longer have access to edit the
requisition.

W o [@Purch&se Requisition lil @ x S @ v |isk Page @Touks e

Smartetools Unified School District
Last Login: 11/27/2009 02:32 PM

Function:

User: Administrator,System Fiscal Year: 2010
5 Save Cancel Copy Req || Templates [ History][ Kactions ][ Motes ][ Print ]
Action: Send to ﬁﬂrchasiﬁgﬁépéﬁ?rieﬁﬁor process.ing -

m

Requisition #: R1000419

Purchase Order #:Not Assigned Current Step:Budget/Fiscal Services

Refer to the Current Step field at the top of the requisition. This shows where the
requisition is currently located in the approval process. This requisition shows
“Budget/Fiscal Services”.

Route a Requisition

Once a purchase requisition has been saved and is complete, it is ready to be
routed to the appropriate departments/personnel for approval, eventually arriving
at its final destination, usually the Purchasing Department.

To route a requisition, choose a route from the Action drop down list. This list
displays the possible routes that the requisition may take. This list is dependent
on the current location/step of the document.

Send to Budget / Fiscal Semnvices for processing
Return Document to New Purchase Req ( Originator )
Return Document to School Principal / Dept Head

Requisition #: R1000426 Purchase Order #:Not Assigned Current Step:Administrator Approval

-

= (| = £ b
W [@ Purchase Requisition I l ﬁ ¥ - o v ;b Page = () Tools »
Smartetools Unified School District
Function: Last Login: 11/27/2009 02:32 PM
User: Administrator,System Fiscal Year: 2010

Purchase Req Listing || Purchase Req

MNew i Edit Save .:'.Cianc—:! ' | Search .Cié:_‘ Req |[ Templates [ History ][ Kactions ][ Nates ][ Print ]
Action: Send to Budget / Fiscal Senvices for processing -

mn

Select a route and click the Go button.

When requisitions are routed, the budget(s) may be checked and a pre-
encumbrance transaction may be created. If any of the accounts on the

[14]
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requisition have insufficient budget for the amount on the requisition, you will see
a message such as the one shown below.

W [@ Purchase Requisition lil @ 7 T @ - |5 Page > @Tools P

-

Smartetools Unified School District M
Function: Last Login: 11/27/2009 02:32 PM
User: Administrator, System Fiscal Year: 2010

Purchase Req Listing || Purchase Req

New Edit Save Cancel | | Search Copy Req || Templates || History || Xactions || Motes Print

m

Action: Send to Administrator for apprn'-:al. - | 50|

The processing of the Purchase Requisition has been halted due to one or more accounts being over
budget. Please review the account message(s) below and press OK to continue with the transaction, or

Mersage ¥ press Cancel to terminate the request.

1 Account (432306) 010-72300-0-11100-36000-4380-807-0000 is Over Pre-Balance by -8500.00;
Requisition #: R1000426 | Go | Purchase Order #:Not Assigned Current Step: School Principal / Dept Head

This message is showing that the amount on the requisition will cause the budget
for the account to be exceeded by $8,500.00. The Cancel button may be the
only button available which means that the requisition cannot be routed until this
over budget condition is corrected. If your district allows over budget conditions,
then an OK button will appear allowing the requisition to be routed.

If the requisition is routed successfully, you will see a message displayed just
below the Action drop down list as follows.

wo [@ Purchase Requisition l_} @ - T @ - |izk Page ¥ @Too&s R

-

Smartetools Unified School District 8
Function: Last Login: 11/27/2009 02:32 PM
User: Administrator, System Fiscal Year: 2010

Purchase Reg Listing || Purchase Req

Save Cancel | Copy Req Templates [ History ][ Xactions ][ Notes ][ Print

Action: Send to Budget / Fiscal Senices for processing -

m

Purchase Requisition has been successfully routed.

View Routing History

To view the routing history and approvals for a requisition, click the History
button. This will display a page that shows the complete routing history of the
requisition.

[15]
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Routing History
Document Number: R1000426

From/Step To/Step Pre- .
Route Name P T i User Date/Time Sent
New Purchase
Req No |Falske,Beth Tuesday, August 11, 2009 01:56 PM
( Originator )
Send to Principal/ MNew Purchase School
Dept. Head for Req Principal / Dept = Mo |Falske,Beth Tuesday, August 11, 2009 02:06 PM
Approval ( Originator ) Head
Send for School -
Administrator Principal / Dept idm;glrs;:lrator Yes Boatright,Shaunte Wednesday, August 12, 2009 01:21 PM
Approval Head PP
Send to Budget/  Administrator Budget/Fiscal s : )
Fiscal Services Approval e Yes |Administrator,System Friday, November 27, 2009 02:41 PM
Ruturn Document : i
to Administrator Budget/Fiscal Administrator Yes |Administrator,System Friday, November 27, 2009 02:41 PM
Services Approval
Approval
Ruturn Document School
to School Administrator s s - :
Principal / Dept Approval Principal / Dept = No |Administrator,System Friday, November 27, 2009 02:41 PM
Head
Head

An example routing history is shown above. The previous location/step, route
taken, new location/step, pre-encumbrance flag, person’s name, and date and
time of the routing are shown. The last entry in the routing history is the current
location of the requisition.

View Transaction Detail

When a requisition is routed, financial transactions may be created to pre-
encumber the amount for each account. To view the financial transaction history,
click the Xactions button. This will display a page showing the financial
transactions for the requisition as shown below.

Account Transaction History

Requisition Mumber: R1000426

§Joumal PO — Debit Credit
él\lumber Ntbor Post Date Account Number Description BIaSHAE Aot
PO REQ:
R1000426,CONSUMERS
|PE145 08/12/2009 010-72300-0-11100-36000-4380-807-0000 PIPE & SUPPLY $2,000.00 $0.00
| PreEncumbrance
| PO REQ:
| R1000426,CONSUMERS
iPE156 11/27/2009 010-72300-0-11100-36000-4380-807-0000 PIPE & SUPPLY $0.00 $2,000.00
| PreEncumbrance
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View and Create Notes

It is possible to create and view notes for a purchase requisition. The Notes
button located on the Menu bar is used to access the Notes page. Click on this
button to display the Notes page. Just below the Menu bar is a comment line with
information about how many notes have been created for the requisition.

The Notes page is displayed below. Click the New Note button to display the
note entry page. Enter your note and click the Save button.

Requisition Notes
Requisition Number: RD0202

NewNote] | Close

Note Date Created
By
Please do not substitute any items. If the items ordered are not available, 45/25/2007 Nedad

Edit | send the requisition back to me and I'll re-submit with an appropriate

substitute. Thanks 03:45:38 PM Yuchno

Close

[ 3 @ Internet | Protected Mode: On H10% -

The saved notes will always be displayed when the Notes page is accessed from
the requisition.
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Print a Purchase Requisition

The purpose of an electronic requisition system is to reduce the amount of paper
that flows through the district. However, many times it is desirable to print a copy
of a requisition for your records. To print a copy of a requisition, first select the
requisition using the Requisition Search function. Once selected, click the Print
button on the Menu bar.

The print function will display a page with the requisition formatted for printing.
You can use your browsers print function to print this page on your printer.

Fiscal Year: 2008 ‘Whirtier Union High School District 30-May-2007 3:29 pm
Purchase Requisition: R00202
Vendor: 172424 Requested By:  Alleese
S & H UNIFORM CO. Requested For-  Jeff
200 WILLIAM STREET Deliver Site: California High School
PORT CHESTER, NY. 10753 -
Countract No:
Date Needed: D6/08/2007
PO Number:
Line Pseudo Account Number Percent Amount PreEncumbrance
1 430611 010-30100-0-11100-10000-4310-401-0000 100.00% 5433.00 $433.00
Acct Description Unit Issue Qty Unit Cost  Taxable Tax Amount Total Cost
Chearleader Unform Each 4 3100.00 Yes 50.00 $0.00
Comments Sub Total: 3400.00 Tax: $0.00 Total: 50.00

Routing History

Route Name From To PreEncum TserName
New Purchase Req o Gowdy,Teff
nd to Asst Principal for Approva MNew Purchas Assistant Principal Mo Gowdy, Jeff
zorical Programs As Categorical Programs Yes YuchnoMickie
fng Categorical Programs Accounting Deparmment Vasg Yuchne Mickie
Send to Purchasing Accounring Deparmment Purchasing Deparonent Vasg Yuchne Mickie
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